
Adding a list box to an Excel sheet can be done using either Form Controls or ActiveX Controls. 

Here's a step-by-step guide for both methods: 

 

Video Link : https://youtu.be/MWOhFZgm39o 

Using Form Controls 

1. Enable the Developer Tab: 

o If the Developer tab is not visible, enable it by going to File > Options > 

Customize Ribbon, and then check the Developer box on the right side. 

2. Insert the List Box: 

o Go to the Developer tab. 

o Click on Insert in the Controls group. 

o Select List Box (Form Control) from the drop-down menu. 

o Click and drag on the worksheet to draw the list box. 

3. Link the List Box to Data: 

o Right-click the list box and select Format Control. 

o In the Control tab, set the Input range to the cells containing your list items. 

o Set the Cell link to a cell where the selected item's index will be stored. 

o Click OK. 

Example Walkthrough 

Let's go through an example where we add a list box using Form Controls: 

1. Prepare your data: 

o Enter your list items in a column, e.g., A1:A5 with values "Item 1", "Item 2", 

"Item 3", "Item 4", "Item 5". 

2. Insert and configure the list box: 
o Enable the Developer tab as described. 

o Insert a List Box (Form Control) and place it on your sheet. 

o Right-click the list box, select Format Control, and set the Input range to 

A1:A5. 

Click here 
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o Set the Cell link to B1 (or any other cell where you want the index of the 

selected item to appear). 

3. Test the list box: 
o Click on the list box and select an item. The index of the selected item will appear 

in the linked cell (B1 in this example). 

By following these steps, you can easily add and configure a list box in an Excel sheet to 

enhance your data interaction. 

To display the customer name selected from the list box, you need to use a combination of the list box 

control and a formula or VBA code, depending on whether you're using a Form Control or ActiveX 

Control. 

Using Form Controls 

1. Prepare Your Data: 

o Enter your list items in a column, for example, A1:A5 with values "Customer 1", 

"Customer 2", "Customer 3", "Customer 4", "Customer 5". 

2. Insert and Configure the List Box: 
o Enable the Developer tab as described before. 

o Insert a List Box (Form Control) and place it on your sheet. 

o Right-click the list box, select Format Control, and set the Input range to 

A1:A5. 

o Set the Cell link to a cell, for example, B1 (this cell will store the index of the 

selected item). 

3. Display the Selected Customer Name: 

o Use a formula to display the customer name based on the index stored in B1. 

o In another cell, for example, C1, enter the following formula: 

=INDEX(A1:A5, B1) 

4. This formula will display the customer name corresponding to the selected index in the 

list box. 

To display the Address, City, and State along with the Name when selecting from a list box in 

Excel, you can organize your data in a structured format and use either a formula-based approach 

(for Form Controls) or VBA (for ActiveX Controls). Below are detailed steps for both methods: 

Using Form Controls 

1. Prepare Your Data: 
o Organize your data in a table-like format. For example: 

makefile 

Copy code 

A1: Name      B1: Address      C1: City      D1: State 

A2: Customer 1 B2: Address 1   C2: City 1    D2: State 1 



A3: Customer 2 B3: Address 2   C3: City 2    D3: State 2 

A4: Customer 3 B4: Address 3   C4: City 3    D4: State 3 

A5: Customer 4 B5: Address 4   C5: City 4    D5: State 4 

A6: Customer 5 B6: Address 5   C6: City 5    D6: State 5 

2. Insert and Configure the List Box: 
o Enable the Developer tab. 

o Insert a List Box (Form Control) and place it on your sheet. 

o Right-click the list box, select Format Control, and set the Input range to 

A2:A6. 

o Set the Cell link to a cell, for example, E1 (this cell will store the index of the 

selected item). 

3. Display the Selected Information: 

o Use formulas to display the customer information based on the index stored in E1. 

o In cells where you want to display the information, use the following formulas: 

 Name: =INDEX(A2:A6, E1) 

 Address: =INDEX(B2:B6, E1) 

 City: =INDEX(C2:C6, E1) 

 State: =INDEX(D2:D6, E1) 

For example: 

F1: Name      -> =INDEX(A2:A6, E1) 

G1: Address   -> =INDEX(B2:B6, E1) 

H1: City      -> =INDEX(C2:C6, E1) 

I1: State     -> =INDEX(D2:D6, E1) 

By following these steps, you can display the customer name along with their address, city, and 

state when selecting from a list box in Excel. 

The formula =VLOOKUP($D$3,Customer!$B$2:$H$11,2,0) uses the VLOOKUP function to 

look up a value in a table and return a corresponding value from a specified column. Let's break 

down each component of this formula: 

Components of the Formula 

1. =VLOOKUP: 

o This is the VLOOKUP function, which stands for "Vertical Lookup". It searches 

for a value in the first column of a range and returns a value in the same row from 

a specified column. 

2. $D$3: 

o This is the lookup value. The dollar signs ($) make the cell reference absolute, 

meaning it will not change if the formula is copied to another cell. 

o The value in cell D3 is what VLOOKUP will search for in the first column of the 

specified range. 

3. Customer!$B$2:$H$11: 



o This specifies the range of cells in the lookup table. The Customer! prefix 

indicates that the range is on a sheet named "Customer". 

o $B$2:$H$11 is an absolute reference to the range of cells from B2 to H11. The 

dollar signs ensure the range remains constant if the formula is copied. 

4. 2: 

o This is the column index number. It specifies which column within the specified 

range to return the value from. 

o In this case, 2 indicates that VLOOKUP should return the value from the second 

column of the range (Customer!$B$2:$H$11). 

5. 0 (or FALSE): 

o This specifies the match type. 0 or FALSE indicates that VLOOKUP should find 

an exact match for the lookup value. 

o If an exact match is not found, the function will return #N/A. 

Putting It All Together 

The formula =VLOOKUP($D$3,Customer!$B$2:$H$11,2,0) does the following: 

 It looks for the value in cell D3 on the current sheet. 

 It searches for this value in the first column of the range Customer!$B$2:$H$11 on the 

"Customer" sheet. 

 If it finds an exact match, it returns the value from the second column of the range (i.e., 

column C if B is the first column in the range). 

 If it does not find an exact match, it returns #N/A. 

 

The formula =INDEX(Customer!$B$2:$B$11,Sheet3!$A$1) is used in Excel to retrieve a value 

from a specified range based on a given position. Here's a breakdown of how this formula works: 

INDEX Function: 

o The INDEX function returns the value of an element in a table or an array, selected 

by the row and column number indexes. 

o Syntax: INDEX(array, row_num, [column_num]) 

Arguments: 

o array: This is the range of cells or array of values from which you want to 

retrieve a value. In this formula, Customer!$B$2:$B$11 is the array, which 

means the range from cell B2 to B11 on the "Customer" sheet. 

o row_num: This specifies the row number in the array from which to return the 

value. In this formula, Sheet3!$A$1 refers to the value in cell A1 on the "Sheet3" 

sheet. This value determines which row of the specified range to pull the data 

from. 



o column_num: This is optional and specifies the column number in the array from 

which to return the value. In this case, it's not needed because the range 

Customer!$B$2:$B$11 is a single column. 

How It Works: 

o The formula looks at the range Customer!$B$2:$B$11. 

o It uses the value in Sheet3!$A$1 to determine which row within this range to 

retrieve the value from. 

o For example, if the value in Sheet3!$A$1 is 3, the formula will return the value 

from the third row in the range Customer!$B$2:$B$11, which is Customer!B4. 

2. If Sheet3!$A$1 contains the number 3, then the formula 

=INDEX(Customer!$B$2:$B$11,Sheet3!$A$1) will return "Steve" because Steve is the 

third entry in the range Customer!$B$2:$B$11. 

Summary 

The formula =INDEX(Customer!$B$2:$B$11,Sheet3!$A$1) dynamically retrieves a value from 

a specified range on the "Customer" sheet based on the row number provided in cell 
Sheet3!$A$1 

The formula =VLOOKUP($B$2,Customer!$B$2:$H$11,2,0) & ", 
"&VLOOKUP($B$2,Customer!$B$2:$H$11,3,0)& "-

"&VLOOKUP($B$2,Customer!$B$2:$H$11,4,0)& ", 

"&VLOOKUP($B$2,Customer!$B$2:$H$11,5,0)& ", Mobile : 

"&VLOOKUP($B$2,Customer!$B$2:$H$11,6,0) is a complex formula that concatenates multiple 

pieces of information retrieved using the VLOOKUP function from the "Customer" sheet. Let's 

break down each part: 

Explanation of Each Component 

1. VLOOKUP Function: 

o The VLOOKUP (Vertical Lookup) function searches for a value in the first column 

of a table and returns a value in the same row from a specified column. 

o Syntax: VLOOKUP(lookup_value, table_array, col_index_num, 
[range_lookup]) 

2. Arguments: 

o lookup_value: The value to search for in the first column of the table_array. In 

this formula, $B$2 is the lookup value, which is a fixed reference to cell B2. 

o table_array: The range of cells that contains the data. Here, 

Customer!$B$2:$H$11 is the range from cell B2 to H11 on the "Customer" sheet. 

o col_index_num: The column number in the table_array from which to retrieve 

the value. 

o [range_lookup]: A logical value (TRUE or FALSE). FALSE (or 0) means an 

exact match is required. 

3. Concatenation (& Operator): 



o The & operator in Excel is used to concatenate (join) multiple strings together. 

Formula Breakdown 

 VLOOKUP($B$2,Customer!$B$2:$H$11,2,0): Looks up the value in $B$2 in the first 

column of the range Customer!$B$2:$H$11 and returns the value from the 2nd column 

of the range. 

 & ", " &: Adds a comma and a space to the result of the first VLOOKUP. 

 VLOOKUP($B$2,Customer!$B$2:$H$11,3,0): Looks up the value in $B$2 and returns 

the value from the 3rd column of the range. 

 & "-" &: Adds a hyphen to the result of the second VLOOKUP. 

 VLOOKUP($B$2,Customer!$B$2:$H$11,4,0): Looks up the value in $B$2 and returns 

the value from the 4th column of the range. 

 & ", " &: Adds a comma and a space to the result of the third VLOOKUP. 

 VLOOKUP($B$2,Customer!$B$2:$H$11,5,0): Looks up the value in $B$2 and returns 

the value from the 5th column of the range. 

 & ", Mobile : " &: Adds the text "Mobile : " to the result of the fourth VLOOKUP. 

 VLOOKUP($B$2,Customer!$B$2:$H$11,6,0): Looks up the value in $B$2 and returns 

the value from the 6th column of the range. 

This formula concatenates multiple pieces of customer information from the "Customer" sheet into a 
single string, combining the first name, last name, address, city, and mobile number with appropriate 
punctuation and text. 

Total Sales : 

The formula =SUMIFS(Sales!D2:D1001,Sales!N2:N1001,Sheet3!B2) is used in Excel to sum 

up values in a specified range based on multiple criteria. Let's break down how this formula 

works: 

Explanation of Each Component 

1. SUMIFS Function: 

o The SUMIFS function sums the values in a range that meet multiple criteria. 

o Syntax: SUMIFS(sum_range, criteria_range1, criteria1, 
[criteria_range2, criteria2], ...) 

2. Arguments: 

o sum_range: This is the range of cells that you want to sum. In this formula, 

Sales!D2:D1001 is the range from cell D2 to D1001 on the "Sales" sheet. 

o criteria_range1: The range that is tested using criteria1. Here, 

Sales!N2:N1001 is the range from cell N2 to N1001 on the "Sales" sheet. 

o criteria1: The condition that defines which cells in criteria_range1 will be 

summed. In this formula, Sheet3!B2 is the criteria, referring to the value in cell 

B2 on the "Sheet3" sheet. 

How It Works 



 Sum Range: Sales!D2:D1001 

o This is the range of values that you want to sum up. It includes cells from D2 to 

D1001 on the "Sales" sheet. 

 Criteria Range: Sales!N2:N1001 

o This is the range that will be evaluated against the criteria. It includes cells from 

N2 to N1001 on the "Sales" sheet. 

 Criteria: Sheet3!B2 

o This is the condition that each cell in the criteria_range1 must meet to be 

included in the sum. It refers to the value in cell B2 on the "Sheet3" sheet. 

Example Scenario 

Assume you have the following data on the "Sales" sheet: 

Column D (Sales Amount) Column N (Sales Region) 

$100 North 

$200 South 

$150 North 

$250 East 

$300 North 

... ... 

$1000 South 

And cell Sheet3!B2 contains the value "North". 

The formula =SUMIFS(Sales!D2:D1001,Sales!N2:N1001,Sheet3!B2) will: 

1. Look at the range Sales!N2:N1001 to find all cells that match "North". 

2. Sum the corresponding values in the range Sales!D2:D1001. 

From the example data, the matching values in column N ("North") are in rows 1, 3, and 5: 

 Row 1: $100 

 Row 3: $150 

 Row 5: $300 

So, the sum will be: 

 $100 + $150 + $300 = $550 

Summary 



The formula =SUMIFS(Sales!D2:D1001,Sales!N2:N1001,Sheet3!B2) sums the values in the 

range Sales!D2:D1001 where the corresponding cells in the range Sales!N2:N1001 match the 

value in Sheet3!B2. In this example, it sums the sales amounts for the "North" region. 

Target: 

The formula =VLOOKUP(B2,Customer!B2:P11,14,0) is used in Excel to look up a value in the 

first column of a specified range and return a value in the same row from a specified column. 

Here’s a breakdown of each part of this formula: 

Explanation of Each Component 

1. VLOOKUP Function: 

o The VLOOKUP (Vertical Lookup) function searches for a value in the first column 

of a table and returns a value in the same row from a specified column. 

o Syntax: VLOOKUP(lookup_value, table_array, col_index_num, 
[range_lookup]) 

2. Arguments: 

o lookup_value: The value to search for in the first column of the table_array. In 

this formula, B2 is the lookup value, which is the value in cell B2 on the current 

sheet. 

o table_array: The range of cells that contains the data to be searched. Here, 

Customer!B2:P11 is the range from cell B2 to P11 on the "Customer" sheet. 

o col_index_num: The column number in the table_array from which to retrieve 

the value. In this formula, 14 indicates that the value should be retrieved from the 

14th column of the range. 

o [range_lookup]: A logical value (TRUE or FALSE). FALSE (or 0) means an 

exact match is required. 

How It Works 

 Lookup Value: B2 

o The formula searches for the value in cell B2 on the current sheet. 

 Table Array: Customer!B2:P11 

o The formula searches within this range on the "Customer" sheet. The first column 

of this range is column B, and the last column is column P. 

 Column Index Number: 14 

o The formula returns the value from the 14th column of the range 

Customer!B2:P11. Since the range starts at column B, the 14th column within 

this range is column O. 

 Range Lookup: 0 (FALSE) 

o The formula requires an exact match for the lookup value. 

Example Scenario 

Assume you have the following data on the "Customer" sheet: 



B C D ... N O P 

101 ... ... ... ... "john.doe@example.com" ... 

102 ... ... ... ... "jane.smith@example.com" ... 

103 ... ... ... ... "mark.jones@example.com" ... 

... ... ... ... ... ... ... 

111 ... ... ... ... "emma.brown@example.com" ... 

If cell B2 on the current sheet contains the value 102, then the formula 

=VLOOKUP(B2,Customer!B2:P11,14,0) will: 

1. Search for 102 in the first column of the range Customer!B2:P11 (which is column B). 

2. Find 102 in row 3 of the range. 

3. Retrieve the value from the 14th column of this range (column O) in the same row. 

4. Return "jane.smith@example.com". 

Summary 

The formula =VLOOKUP(B2,Customer!B2:P11,14,0) looks up the value in cell B2 on the 

current sheet within the range Customer!B2:P11 on the "Customer" sheet. It then returns the 

value from the 14th column of this range (column O) where an exact match is found. In this 

example, it returns the email address associated with the customer ID found in cell B2. 

Achivement : 

The formula =D7/F7*100 is used in Excel to calculate the percentage of the value in cell D7 

relative to the value in cell F7. Here's a breakdown of how this formula works: 

Explanation of Each Component 

1. Division: D7/F7 

o This part of the formula divides the value in cell D7 by the value in cell F7. This 

operation calculates what fraction of F7 is represented by D7. 

2. Multiplication by 100: *100 

o The result of the division is then multiplied by 100. This step converts the fraction 

into a percentage. 

How It Works 

Assume the following values in cells D7 and F7: 

 D7: 50 

 F7: 200 

The formula =D7/F7*100 will perform the following calculations: 



1. Division: 50 / 200 

o This results in 0.25. 

2. Multiplication by 100: 0.25 * 100 

o This results in 25. 

So, =D7/F7*100 will return 25, meaning that the value in D7 is 25% of the value in F7. 

Summary 

The formula =D7/F7*100 calculates the percentage of the value in cell D7 relative to the value in 

cell F7 by dividing D7 by F7 and then multiplying the result by 100 to convert it to a percentage. 

Amt. Dues : 

The formula =SUMIFS(Sales!D2:D1001,Sales!N2:N1001,Sheet3!B2,Sales!H2:H1001,"N") 

is used in Excel to sum values in a specified range based on multiple criteria. Let's break down 

each part of this formula: 

Explanation of Each Component 

1. SUMIFS Function: 

o The SUMIFS function sums the values in a range that meet multiple criteria. 

o Syntax: SUMIFS(sum_range, criteria_range1, criteria1, 
[criteria_range2, criteria2], ...) 

2. Arguments: 

o sum_range: This is the range of cells that you want to sum. In this formula, 

Sales!D2:D1001 is the range from cell D2 to D1001 on the "Sales" sheet. 

o criteria_range1: The first range that is tested using criteria1. Here, 

Sales!N2:N1001 is the range from cell N2 to N1001 on the "Sales" sheet. 

o criteria1: The condition that defines which cells in criteria_range1 will be 

summed. In this formula, Sheet3!B2 is the criteria, referring to the value in cell 

B2 on the "Sheet3" sheet. 

o criteria_range2: The second range that is tested using criteria2. Here, 

Sales!H2:H1001 is the range from cell H2 to H1001 on the "Sales" sheet. 

o criteria2: The condition that defines which cells in criteria_range2 will be 

summed. In this formula, it is "N". 

How It Works 

 Sum Range: Sales!D2:D1001 

o This is the range of values that you want to sum up. It includes cells from D2 to 

D1001 on the "Sales" sheet. 

 First Criteria Range: Sales!N2:N1001 

o This is the range that will be evaluated against the first criteria. It includes cells 

from N2 to N1001 on the "Sales" sheet. 



 First Criteria: Sheet3!B2 

o This is the condition that each cell in Sales!N2:N1001 must meet to be included 

in the sum. It refers to the value in cell B2 on the "Sheet3" sheet. 

 Second Criteria Range: Sales!H2:H1001 

o This is the range that will be evaluated against the second criteria. It includes cells 

from H2 to H1001 on the "Sales" sheet. 

 Second Criteria: "N" 

o This is the condition that each cell in Sales!H2:H1001 must meet to be included 

in the sum. It looks for cells that exactly match "N". 

Example Scenario 

Assume you have the following data on the "Sales" sheet: 

Column D (Sales Amount) Column N (Region) Column H (Status) 

$100 North N 

$200 South Y 

$150 North N 

$250 East N 

$300 North Y 

... ... ... 

$400 North N 

And cell Sheet3!B2 contains the value "North". 

The formula =SUMIFS(Sales!D2:D1001,Sales!N2:N1001,Sheet3!B2,Sales!H2:H1001,"N") 

will: 

1. Look at the range Sales!N2:N1001 to find all cells that match "North". 

2. Among those matching rows, it further checks the range Sales!H2:H1001 for cells that 

match "N". 

3. Sum the corresponding values in the range Sales!D2:D1001. 

From the example data, the matching rows are: 

 Row 1: Sales Amount = $100, Region = North, Status = N 

 Row 3: Sales Amount = $150, Region = North, Status = N 

 Row 7: Sales Amount = $400, Region = North, Status = N 

So, the sum will be: 

 $100 + $150 + $400 = $650 

Summary 



The formula =SUMIFS(Sales!D2:D1001,Sales!N2:N1001,Sheet3!B2,Sales!H2:H1001,"N") 

sums the values in the range Sales!D2:D1001 where the corresponding cells in 

Sales!N2:N1001 match the value in Sheet3!B2 and the corresponding cells in Sales!H2:H1001 

match "N". In this example, it sums the sales amounts for the "North" region where the status is 

"N". 

Dues % : 

The formula =ROUND(J7/D7*100,0) is used in Excel to calculate the percentage of the value in 

cell J7 relative to the value in cell D7 and then round the result to the nearest whole number. 

Here’s a breakdown of each part of this formula: 

Explanation of Each Component 

1. Division: J7/D7 

o This part of the formula divides the value in cell J7 by the value in cell D7. This 

operation calculates what fraction of D7 is represented by J7. 

2. Multiplication by 100: *100 

o The result of the division is then multiplied by 100. This step converts the fraction 

into a percentage. 

3. Rounding: ROUND(...,0) 

o The ROUND function rounds a number to a specified number of digits. 

o Syntax: ROUND(number, num_digits) 

 number: The number to be rounded. Here, it is the result of J7/D7*100. 

 num_digits: The number of digits to which you want to round the 

number. In this case, 0 means rounding to the nearest whole number. 

How It Works 

Assume the following values in cells J7 and D7: 

 J7: 50 

 D7: 200 

The formula =ROUND(J7/D7*100,0) will perform the following calculations: 

1. Division: 50 / 200 

o This results in 0.25. 

2. Multiplication by 100: 0.25 * 100 

o This results in 25. 

3. Rounding: ROUND(25,0) 

o This rounds 25 to 0 decimal places, which is still 25. 

So, =ROUND(J7/D7*100,0) will return 25, meaning that the value in J7 is 25% of the value in 

D7, rounded to the nearest whole number. 



Summary 

The formula =ROUND(J7/D7*100,0) calculates the percentage of the value in cell J7 relative to 

the value in cell D7 by dividing J7 by D7, multiplying the result by 100 to convert it to a 

percentage, and then rounding the result to the nearest whole number. This formula is useful for 

presenting percentage values as whole numbers without any decimal places. 

Nested IF statements: (Achive %) 

The formula =IF(H7>99, "Excellent", IF(H7>89, "Try Better", "Very Poor")) is an 

example of nested IF statements in Excel, used to evaluate a cell value and return different text 

outcomes based on specified conditions. Here's a detailed breakdown: 

Explanation of Each Component 

1. Outer IF Statement: IF(H7>99, "Excellent", ...) 

o The formula first checks if the value in cell H7 is greater than 99. 

o If this condition is true (H7>99), the formula returns "Excellent". 

o If this condition is false, the formula evaluates the next IF statement. 

2. Nested IF Statement: IF(H7>89, "Try Better", "Very Poor") 

o If the first condition (H7>99) is false, the formula then checks if the value in cell 

H7 is greater than 89. 

o If this second condition (H7>89) is true, the formula returns "Try Better". 

o If this second condition is also false, the formula returns "Very Poor". 

How It Works 

 Condition 1: H7 > 99 

o If the value in H7 is greater than 99, the formula returns "Excellent". 

 Condition 2: H7 > 89 

o If the value in H7 is not greater than 99, the formula then checks if it is greater 

than 89. 

o If the value in H7 is greater than 89 (and 99 or less), the formula returns "Try 

Better". 

 Default Case: 

o If neither condition (greater than 99 or greater than 89) is met, the formula returns 

"Very Poor". 

Example Scenario 

Assume the following values for H7: 

 If H7 = 100, the formula checks: 

1. Is 100 > 99? Yes, so it returns "Excellent". 

 If H7 = 95, the formula checks: 



1. Is 95 > 99? No. 

2. Is 95 > 89? Yes, so it returns "Try Better". 

 If H7 = 85, the formula checks: 

1. Is 85 > 99? No. 

2. Is 85 > 89? No, so it returns "Very Poor". 

Summary 

The formula =IF(H7>99, "Excellent", IF(H7>89, "Try Better", "Very Poor")) 

evaluates the value in cell H7 and returns: 

 "Excellent" if the value is greater than 99. 

 "Try Better" if the value is between 90 and 99 (inclusive of 90 but exclusive of 100). 

 "Very Poor" if the value is 89 or less. 

This nested IF statement structure allows for multiple conditional checks and corresponding 

outputs. 

Nested IF statements: (Dues %) 

The formula =IF(J7>250000, "Stop Supply", IF(J7>200000, "Danger", IF(J7>150000, 

"Alarming", "Careful"))) uses nested IF statements to evaluate the value in cell J7 and 

return different text outcomes based on specified thresholds. Here's a detailed breakdown of how 

the formula works: 

Explanation of Each Component 

1. Outer IF Statement: IF(J7>250000, "Stop Supply", ...) 
o The formula first checks if the value in cell J7 is greater than 250,000. 
o If this condition is true (J7>250000), the formula returns "Stop Supply". 
o If this condition is false, the formula evaluates the next IF statement. 

2. First Nested IF Statement: IF(J7>200000, "Danger", ...) 
o If the first condition (J7>250000) is false, the formula then checks if the value in cell J7 

is greater than 200,000. 
o If this second condition (J7>200000) is true, the formula returns "Danger". 
o If this second condition is false, the formula evaluates the next IF statement. 

3. Second Nested IF Statement: IF(J7>150000, "Alarming", "Careful") 
o If the first and second conditions (J7>250000 and J7>200000) are false, the formula 

checks if the value in cell J7 is greater than 150,000. 
o If this third condition (J7>150000) is true, the formula returns "Alarming". 
o If this third condition is also false, the formula returns "Careful". 

How It Works 

 Condition 1: J7 > 250000 
o If the value in J7 is greater than 250,000, the formula returns "Stop Supply". 



 Condition 2: J7 > 200000 
o If the value in J7 is not greater than 250,000, the formula then checks if it is greater than 

200,000. 
o If the value in J7 is greater than 200,000 (and 250,000 or less), the formula returns 

"Danger". 

 Condition 3: J7 > 150000 
o If the value in J7 is not greater than 250,000 or 200,000, the formula then checks if it is 

greater than 150,000. 
o If the value in J7 is greater than 150,000 (and 200,000 or less), the formula returns 

"Alarming". 

 Default Case: 
o If none of the above conditions are met (the value in J7 is 150,000 or less), the formula 

returns "Careful". 

Example Scenario 

Assume the following values for J7: 

 If J7 = 300000, the formula checks: 
1. Is 300000 > 250000? Yes, so it returns "Stop Supply". 

 If J7 = 225000, the formula checks: 
1. Is 225000 > 250000? No. 
2. Is 225000 > 200000? Yes, so it returns "Danger". 

 If J7 = 175000, the formula checks: 
1. Is 175000 > 250000? No. 
2. Is 175000 > 200000? No. 
3. Is 175000 > 150000? Yes, so it returns "Alarming". 

 If J7 = 125000, the formula checks: 
1. Is 125000 > 250000? No. 
2. Is 125000 > 200000? No. 
3. Is 125000 > 150000? No, so it returns "Careful". 

Summary 

The formula =IF(J7>250000, "Stop Supply", IF(J7>200000, "Danger", IF(J7>150000, 

"Alarming", "Careful"))) evaluates the value in cell J7 and returns: 

 "Stop Supply" if the value is greater than 250,000. 
 "Danger" if the value is between 200,001 and 250,000. 
 "Alarming" if the value is between 150,001 and 200,000. 
 "Careful" if the value is 150,000 or less. 

This nested IF statement structure allows for multiple conditional checks and corresponding 

outputs, providing a clear categorization of the value in J7 based on specified thresholds. 

Conditional formatting: 



To apply conditional formatting in Excel to display different texts ("Stop Supply", "Danger", 

"Alarming", and "Careful") in cell L9 based on the value in another cell (e.g., J9), you can follow 

these steps: 

Steps to Apply Conditional Formatting 

1. Select Cell L9: 
o Click on cell L9 where you want to apply the conditional formatting. 

2. Open Conditional Formatting: 
o Go to the "Home" tab on the Excel ribbon. 
o Click on "Conditional Formatting" in the "Styles" group. 
o Choose "New Rule" from the drop-down menu. 

3. Create New Rules: 
o In the "New Formatting Rule" dialog box, select "Use a formula to determine which cells 

to format". 

4. Add the First Rule (Stop Supply): 
o Enter the formula =L9="Stop Supply" 
o Click on the "Format" button. 
o In the "Format Cells" dialog box, go to the "Font" tab. 
o Choose the desired font color, style, or other formatting options for the "Stop Supply" 

text. 
o Click "OK" to close the "Format Cells" dialog box. 
o Click "OK" to close the "New Formatting Rule" dialog box. 

5. Repeat for Other Rules: 
o Repeat steps 2-4 to add more rules for the other texts: 

 For "Danger": 
 Enter the formula =L9="Danger" 
 Choose the desired formatting for the "Danger" text. 

 For "Alarming": 
 Enter the formula =L9="Alarming" 
 Choose the desired formatting for the "Alarming" text. 

 For "Careful": 
 Enter the formula =L9="Careful" 
 Choose the desired formatting for the "Careful" text. 

Summary 

By following these steps, you will have applied conditional formatting to cell L9 to display 

different texts ("Stop Supply", "Danger", "Alarming", and "Careful") based on the value in cell 

L9. The conditional formatting rules will ensure that each text has its own distinct formatting, 

making it easy to distinguish between the different conditions. 

Remarks : 

The formula =IF(H7>=100, "Implement a special scheme and increase the target by 
10%", IF(H7>=95, "Encourage the customer to achieve a 100% target", 

IF(H7>=90, "Make a concerted effort to improve your sales", "If sales do not 



improve within the next 90 days, your contract will be reviewed "))) is a nested 

IF statement that evaluates the value in cell H7 and returns different text outcomes based on 

specified conditions. Here’s a detailed breakdown of how the formula works: 

Explanation of Each Component 

1. Outer IF Statement: IF(H7>=100, "Implement a special scheme and increase 
the target by 10%", ...) 

o The formula first checks if the value in cell H7 is greater than or equal to 100. 
o If this condition is true (H7>=100), the formula returns "Implement a special scheme 

and increase the target by 10%". 
o If this condition is false, the formula evaluates the next IF statement. 

2. First Nested IF Statement: IF(H7>=95, "Encourage the customer to achieve a 
100% target", ...) 

o If the first condition (H7>=100) is false, the formula then checks if the value in cell H7 is 
greater than or equal to 95. 

o If this second condition (H7>=95) is true, the formula returns "Encourage the customer 
to achieve a 100% target". 

o If this second condition is false, the formula evaluates the next IF statement. 

3. Second Nested IF Statement: IF(H7>=90, "Make a concerted effort to improve 
your sales", ...) 

o If the first and second conditions (H7>=100 and H7>=95) are false, the formula checks if 
the value in cell H7 is greater than or equal to 90. 

o If this third condition (H7>=90) is true, the formula returns "Make a concerted effort to 
improve your sales". 

o If this third condition is also false, the formula returns the default text. 

4. Default Case: 
o If none of the above conditions are met (the value in H7 is less than 90), the formula 

returns "If sales do not improve within the next 90 days, your contract will be 
reviewed". 

How It Works 

 Condition 1: H7 >= 100 
o If the value in H7 is greater than or equal to 100, the formula returns "Implement a 

special scheme and increase the target by 10%". 

 Condition 2: H7 >= 95 
o If the value in H7 is not greater than or equal to 100, the formula then checks if it is 

greater than or equal to 95. 
o If the value in H7 is greater than or equal to 95 (and less than 100), the formula returns 

"Encourage the customer to achieve a 100% target". 

 Condition 3: H7 >= 90 
o If the value in H7 is not greater than or equal to 100 or 95, the formula then checks if it 

is greater than or equal to 90. 
o If the value in H7 is greater than or equal to 90 (and less than 95), the formula returns 

"Make a concerted effort to improve your sales". 

 Default Case: 



o If none of the above conditions are met (the value in H7 is less than 90), the formula 
returns "If sales do not improve within the next 90 days, your contract will be 
reviewed". 

Example Scenario 

Assume the following values for H7: 

 If H7 = 105, the formula checks: 
1. Is 105 >= 100? Yes, so it returns "Implement a special scheme and increase the target by 

10%". 

 If H7 = 97, the formula checks: 
1. Is 97 >= 100? No. 
2. Is 97 >= 95? Yes, so it returns "Encourage the customer to achieve a 100% target". 

 If H7 = 92, the formula checks: 
1. Is 92 >= 100? No. 
2. Is 92 >= 95? No. 
3. Is 92 >= 90? Yes, so it returns "Make a concerted effort to improve your sales". 

 If H7 = 85, the formula checks: 
1. Is 85 >= 100? No. 
2. Is 85 >= 95? No. 
3. Is 85 >= 90? No, so it returns "If sales do not improve within the next 90 days, your 

contract will be reviewed". 

Summary 

The formula =IF(H7>=100, "Implement a special scheme and increase the target by 
10%", IF(H7>=95, "Encourage the customer to achieve a 100% target", 

IF(H7>=90, "Make a concerted effort to improve your sales", "If sales do not 

improve within the next 90 days, your contract will be reviewed "))) evaluates 

the value in cell H7 and returns: 

 "Implement a special scheme and increase the target by 10%" if the value is 100 or greater. 
 "Encourage the customer to achieve a 100% target" if the value is between 95 and 99. 
 "Make a concerted effort to improve your sales" if the value is between 90 and 94. 
 "If sales do not improve within the next 90 days, your contract will be reviewed" if the value is 

less than 90. 

This nested IF statement structure allows for multiple conditional checks and corresponding text 

outputs based on the value in H7. 

You can use the IFS function if you are using Excel 2016 or later! 

The nested IF statement you provided is in the correct format and will work as intended in Excel. 

However, nested IF statements can become difficult to read and maintain as the complexity 

increases. For better readability and maintainability, you can use the IFS function if you are 



using Excel 2016 or later. The IFS function allows you to evaluate multiple conditions in a more 

straightforward way. 

Using the IFS Function 

The IFS function can simplify the nested IF structure. Here is how you can rewrite the formula 

using IFS: 

=IFS( 

    H7 >= 100, "Implement a special scheme and increase the target by 10%", 

    H7 >= 95, "Encourage the customer to achieve a 100% target", 

    H7 >= 90, "Make a concerted effort to improve your sales", 

    TRUE, "If sales do not improve within the next 90 days, your contract 

will be reviewed" 

) 

Explanation 

 IFS Function: The IFS function checks multiple conditions and returns a corresponding value 
for the first true condition. 

 Conditions: 
o H7 >= 100: If the value in H7 is 100 or greater, it returns "Implement a special scheme 

and increase the target by 10%". 
o H7 >= 95: If the value in H7 is 95 or greater but less than 100, it returns "Encourage 

the customer to achieve a 100% target". 
o H7 >= 90: If the value in H7 is 90 or greater but less than 95, it returns "Make a 

concerted effort to improve your sales". 
o TRUE: This is a catch-all condition that returns "If sales do not improve within the next 

90 days, your contract will be reviewed" if none of the above conditions are met. 

Example 

Using the IFS function: 

 If H7 = 105, the formula returns "Implement a special scheme and increase the target by 10%". 
 If H7 = 97, the formula returns "Encourage the customer to achieve a 100% target". 
 If H7 = 92, the formula returns "Make a concerted effort to improve your sales". 
 If H7 = 85, the formula returns "If sales do not improve within the next 90 days, your contract 

will be reviewed". 

Summary 

The IFS function simplifies the structure of nested IF statements, making the formula easier to 

read and maintain. The rewritten formula using IFS achieves the same logic as your original 

nested IF formula but in a more readable format. If you are using a version of Excel that 

supports the IFS function, it is recommended to use it for better clarity. 



How to Insert Picture : 

 

You can insert pictures into Excel cells. Here are a few methods to do so: 

1. Using the Ribbon (Excel for Windows or Mac): 

o Go to the Insert tab. 

o Click on Pictures in the Illustrations group. 

o Select Place in Cell from the dropdown menu. 

o Choose one of the following sources: 

 This Device: To insert a picture from your device. 

 Stock Images: For stock images. 

 Online Pictures: To insert a picture from the web. 

o Select your picture and click Insert. 

2. Using the IMAGE Function (Excel for the web): 

o The IMAGE function allows you to insert pictures using a web URL path. You can specify 

the URL directly in a cell. 

o Example: =IMAGE("https://example.com/image.jpg") 

3. Pasting from Clipboard: 

o If you have an image in your clipboard, you can paste it directly into a cell as a picture. 

o Right-click in the cell and choose Paste Picture in Cell. 

Remember to adjust the size and position of the image as needed. Also, consider 

adding alt text for accessibility. 
 

Add a hyperlink to an image : 

You can add a hyperlink to an image in Excel by following these steps: 

1. Insert the Image: 

o First, insert the image into your Excel sheet using one of the methods I mentioned 

earlier. 

o You can use the Insert tab and choose Pictures to add the image. 

2. Add a Hyperlink: 

o Right-click on the image you inserted. 

o Select Hyperlink from the context menu. 

o In the Insert Hyperlink dialog box: 

 Choose Existing File or Web Page if you want to link to a file or a web page. 



 Enter the URL or browse to the file you want to link to. 

 Click OK to create the hyperlink. 

3. Test the Hyperlink: 

o Click on the image to test the hyperlink. 

Remember to adjust the image size and position as needed. Now you’ll have an image 

with an associated hyperlink! 
 

 

 

 

 

 

 

If you have any queries, please visit our "Contact Me" page. 

Thank You. See you again! 
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